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The Konstanz Information Miner

* Available at https://www.knime.org/

 KNIME is an open source data analytics platform.

e Uses pipeline philosophy.

* Nodes for machine learning and data mining.
 Modeling, data analysis, visualization and reporting.

Berthold MR, Cebron N, Dill F & Gabriel TR. The Konstanz Information Minef. in Studies in Classification, Data
Analysis, and Knowledge Organization (GfKL 2007); 11: 319-32 ringer, 2007)
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https://www.knime.org/

Data for this workshop

Please download files:

* |ris: https://ocw.mit.edu/courses/sloan-school-of-
management/15-097-prediction-machine-learning-and-
statistics-spring-2012/datasets/

 Walkey:
https://data.enanomapper.net/substanceowner/FCSV-
319611C6-E7DA-3977-A5AC-EB74D49A4319/dataset

- Export as CSV
* Gene to Protein IDs Dictionary: distributed locally
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Getting Started

15t time users: Open KNIME, Enter Name of default worksy
LB
* Returning users: Open KNIME, Select default workspace

* File ->New ...
e New KNIME Workflow -> Next

A

Select a wizard

 Type Name -> Finish

This wizard creates a new KNIME worlflow project.

Wizards:
type filter text

[ £ New KNIME Workflow
A5 Mew ENIME Workflow Group
s+ =+ General

» [~ Business Intelligence and Reporting Tools
» = Connection Profiles

sy = Java
= KNIME
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What the interface

File Edit View MNode Help

[[100% v]a| § ~[J2O0OOCDOOS =

CEHmx @O R

C-BHER A&
A KNIME Explorer 57 | =8
2E|HE vl &

[+ G5 EXAMPLES (guest@publicserver.knime.org:47037)
> % LOCAL (Local Workspace)

o Favorite Nodes 52 =] Z % = 0

W Personal favorite nodes
> ©7 Most frequently used nodes
1+ (T} Last used nodes

A Node Repositoryl

a ply 10 ~
a B Write
FH CSV Wiriter
BET ARFF Writer
B Table Writer
S PMML Writer
% Model Writer
E XLS Sheet Appender
E KLS Writer
4 =% Other
25 Image Column Writer
&L Image Port Writer
4 [E Database

4 7 Daad Al

A% 0 VeniceTutorial &2 = 0O |4 Node Description &2 = 0
p
~
Row Filter Column Filter External Tool
—+l, b
e L= 2 [ @
MNode 15 Node 16 MNode 14
GET Resource POST Resource JSON Reader
oA t
Mode 1 MNode 13
Node 2
String to JSON
S -
Node 4
v
£ >
EEGutIine%l ¥ = 0O | & Console 2 I:—='|'|5E|‘._.’E'rﬁ':ﬁ
KNIME Console
WARH External Tool Existing output file will be overricsa
WARN External Tool Existing input and output files will
WARH External Tool Existing input file will be overridc
WARN External Tool Existing output file will be owverric
v
= < >
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KNIME Windows (from View Menu)

 KNIME Explorer: Workflows saved previously

* Favorite Nodes: Most frequently used

* Node repository: All nodes available

e Qutline: Map of current workflow

e Console: Messages from KNIME (warnings/errors)

* Node Description: Info about the node functionality and ports
* Workflow window

BENM
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Node Repository

* Nodes Under Categories A NodeRepositoy, || [

4 ey 10 L

* 1/0, RDKit, KNIME Labs, Weka, etc... | &% o

s . B3 ARFF Reader
* 1/0O contains readers and writers B C5V Rence
"3 Table Reader
o PMML Reader
. T4 Model Reader
° Drop down menu or type in search [#] Fixed Width File Reader
[3€ Read XLS Sheet Names
Bl XLS Reader

* To insert into workflow + & Other

R s Y, R O (N, WP, P

* Double Click on node or drag and drop ,
 Try CSV Reader
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CSV Reader B

Flow Variables Job Manager Selection Memory Falicy

See:
* What it does (Right: Node description) | |cueomssrmmrme -
 How to configure

Column Delimiter n Row Delimiter

# Commen t Char

Quote Char

e Useiris.csv

Has Column Header Has Row Header

 How to execute

[] Support Short Lines

[] skip first lines

* View results

[] Limit rows

* Connect to another node
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Statistics and Color Nodes

File

A

File

Color Settings

Flow Variables | Job Manager Selection | Memaory Policy

Select one Column

Range

Swatches | HSV | HSL | RGE | CMYK | Alpha

Preview

Recent:

IJJJJJJJJH

0K Apply

Cancel @ c

29 September 2016

Options | Histogram | Flow Variables | Job Manager Selection | Memary Policy
[] Calculate median values (computationally expensive) 5 dass
rMominal values (®) Nominal
(®) Manual Selection () Wildcard/Regex Selection (_) Type Selection M Iris-setoss
Exclude Select - Include I ris-versicolor
. Iris-virginica
Column({s): Search add >> Column(s): Search
[] select all search hits [] select all search hits
add all => § dass
[+ petal width << remove
<< remove all
() Enforce exdusion (®) Enforce indusion
Max no. of most frequent and infrequent values (in view): 205
. Statistics
Max no. of possible values per column {in output table): 1,000
[[] Enable HiLite _B
L
C5V Reader Node 2
0K Apply Cancel @
=N
L]
Mode 1 .. Color Manager
]
Node 3

@
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File

First partition | Flow Variables | Job Manager Selection | Memary Policy

Choose size of first partition

(") Absolute 100 CSV Reader Node 2 Partitioning

(®) Relative[%] Fie= } —
o - &

() Take from top

(") Linear sampling ;

(@) Draw randomly

(") Stratified sampling 5 dass

[ ] use random seed 1,474,886,222 ¢
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: Spec - Columns: & | Properties | Flow Variables

29 September 2016

Flow Variables Job Manager Selection Memary Paolicy Row ID D sepdle...| D sepalw...| D petalle... | D petal wi...| § dass SF
Options PMMLSettings Rowl 4.9 3 1.4 0.2 Iris-setosa Iris-sé A

G I Row2 4.7 3.2 1.3 0.2 Iris-setosa Iris-s¢

Enera Rowé 4.6 3.4 1.4 0.3 Iris-setosa Iris-s¢

Class column | § dass w Row? 5 3.4 15 0.2 Iris-setosa Iris-s¢

Row10 5.4 3.7 15 0.2 Iris-setosa Iris-s¢

Quality measure | Gini index v Rowll 4.8 3.4 16 0.2 Iris-setosa Iris-s¢

Row12 4.8 3 1.4 0.1 Iris-setosa Iris-s¢

wi3 4.3 3 1.1 0.1 Iris-setosa Iris-s¢

Pruning methed | No pruning v T w22 4.6 3.6 1 02 Irissetosa _[Iris—=¢

Decision w24 4.3 3.4 1.9 0.2 Irissetosa  |Iris-s¢

Reduced Error Pruning Tree Learner w25 5 3 16 0.2 Iris-setosa  |Iris-s¢

w2s 5 3.4 16 0.4 Iris-setosa Iris-s¢

Min rumber recn s per ik 2 : —p I'I::-I B w27 5.2 3.5 1.5 0.2 Ir?s&ehosa Ir?s&t

Decision Tree w30 4.8 3.1 16 0.2 Ir!Siehosa Ir!sii

X " —— - —+ w34 4.9 3.1 1.5 0.2 Iris-setosa Iris-s¢

Number records to store for view 10,000 5 Partitioning ] Predictor 5 o = 13 02 TS

> Mode B ] w37 4.9 3.6 1.4 0.1 Iris-setosa Iris-st

Average split point —»> % L ‘ w4l 4.5 2.3 1.3 0.3 Iris-setosa Iris-5¢

i was 5 3.3 1.4 0.2 Iris-setosa Iris-s¢

Mumber threads Py 2 2 w1l 5.9 3 4.2 15 Iris-versicolor [Iris-w

we7 5.8 2.7 4.1 1 Iris-versicolor [Iris-w

. . . L X Node 4 Mode 6 wi7 6.7 3 5 1.7 Iris-versicolor  (Iris-vi

Skip nominal columns without domain information wan 55 03 BB 11 Iris-versicolor [Irisan

Rowg1l 5.5 2.4 3.7 1 Iris-versicolor [Iris-w

~Binary nominal splits Row34 5.4 3 4.5 1.5 Iris-versicolor |Iris-wi

Row3a2 5.8 2.6 4 1.2 Iris-versicolor [Iris-w

|:| Binary nominal splits Row33 5 2.3 3.3 1 Iris-versicolor [Iris-w

Row3s 5.1 2.5 3 1.1 Iris-versicolor [Iris-w

. - Row102 7.1 3 5.9 2.1 Iris-virginica  [Iris-vi

Max #nominal 0f= Row104 .5 3 5.8 22 Iris-virginica _|[Iris—vi

Row105 7.6 3 6.6 2.1 Iris-virginica  [Iris-vi

[ Filter invalid attribute values in child nodes Row107 7.3 2.9 5.3 1.3 Tris-virginica _|Iris—vi

Row110 6.5 3.2 51 2 Iris-virginica  [Iris-vi

Row112 5.8 3 5.5 2.1 Iris-virginica  [Iris-vi

Row114 5.8 2.8 51 2.4 Iris-virginica  [Iris-vi

Row117 7.7 3.8 6.7 2.2 Iris-virginica  [Iris-vi

0K Apply Cancel @ Row118 7.7 26 6.9 2.3 Tris-virginica _ [Tris-vi

D11 C &R e 4 a el Trie s sirmimicrs Trie i

£ >

@
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»
File File
i Table "spec_name” - Rows: 3i| Spec - Columns: 3 | Properties | Flow Variables
Scorer | Flow Variables | Job Manager Selection | Memary Policy Row ID | Irsset..| | Irs~ver...| | Iris—virg...
First Column Iris-setosa 19 ] 0
Iris-versicolor |0 a 1
B Iris-virginica |0 0 17
Second Column
5 Prediction (dass) w
Sorting of values in tables
Sorting strategy: | Insertion order w |:| Reverse order
Provide scores as flow variables
[] Use name prefix Decisic!n Tree
Predictor Scorer -
Missing values — >
b E -
In case of missing values... (@) Ignore ™ ® ' -" g
() Fai Mode 6 Node 7 k. 8

Cancel
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LinearRegression

(3.7)
- Q B
. Weka Predictor
Column Filter Partitioning [ ] ™ {3.7) Numeric Scorer
> Mode 11

i

f >
® °

Mode 9 Mode 10
LinearBegressiomn File

iTable "Scores” - Rows: 5 | Spec - Column: 1 | Properties | Flow Variables

Linear Begres=ion Model

Fow ID D Predicti...

R~2 0.947
mean absolut... (0,143
mean sguare... (0.031
root mean sqg... (0,175
mean signed ... |0.056

petalwidth =

-0.2142 4 mepallength +
0.20E * =epalwidth +
0.5235 * petallength +

-0.1344
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File

Standard settings | Flow Variables | Job Manager Selection I Memary Policy

Column with dass labels
Mumber of neighbours to consider (k)
Weight neighbours by distance

Cutput dass probabilities

5 dass v

[
L

Elca

29 September 2016

Decision
Tree Learner

—p r"f' B

Partitioning ]
_p OO b— Mode 5
y ooy
® W\
Mode 4 ' Kmm Neighbor
N % »
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Writing Tables to Disc

* Helps save memory
e Takes longer for calculations

29 September 2016

CsV Reader | Flow Variables | Memory Policy

Select memory policy for data outport(s)

() Keep all in memary,
() Keep only small tables in memory.

(@) Write tables to disc.
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Clear Memory after calculations

* File -> Preferences -> General -> Show Heap Status

A

type filter text

- Ant

[- Data Management

>

- Help

Install/Update

Java

KMIME

Plug-in Development
RapidMiner Preferences
Report Design
Run/Debug

Team

e v v v L

29 September 2016

&

: j" *

e

General

[ ] Always run in background
[ | Keep next/previous editor, view and perspectives dialog open
Show heap status
Open mode
(®) Double click
() Single click
Select on hover
Open when using arrow keys

Mote: This preference may not take effect on all views.
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Dataset for Task 2

* http://pubs.acs.org/doi/abs/10.1021/nn406018q

Protein Corona Fingerprinting Predicts the Cellular Interaction of Gold
and Silver Nanoparticles

Carl D. Walkey{§, Jonathan B. Olsent§, Fayi Song{§, Rong LiuV&, Hongbo Guol§, D. Wesley H. Olsen{1§,
Yoram CohenV®, Andrew Emilil§, and Warren C. W. Chant§.LI#

TInstitute of Biomaterials and Biomedical Engineering, *Banting and Best Department of Medical Research, 2Donnelly
Centre for Cellular and Biomolecular Research, {Department of Chemical Engineering, 'Department of Chemistry,
*Department of Materials Science and Engineering, University of Toronto, Toronto, Ontario, Canada M55 3G9
"Center for Environmental Implications of Nanotechnology, ®Chemical and Biomolecular Engineering Department,
University of California, Los Angeles, California 90095, United States

ACE Nano, 2014, § (3), pp 2439-2455

DOl 10.1021/nnd06018q

FPublication Date (Web): February 11, 2014
Copyright @ 2014 American Chemical Society

*Address correspondence to warren.chan@utoronto.ca.

» Made available at https://data.enanomapper.net
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File

i Table “walkey.csv” - Rows: 100} Spec - Columns: 823 | Properties | Flow Variables

File

Row ID

§ NP ID

S Element

S Abbrevi...

§ Classifi...

TR

o VL

| |

L

rIoTT

D Metcel.

i Table “walkey.csv™ - Rows: 84! Spec - Columns: 823 | Properties | Flow Variables

~

Rowg1

G60.5er-5H_1

[Au]

Ser-5H

Anionic

0.061

Rowd2

GG0.5PP_1

[Au]

SPP

Anionic

0.046

Rowd3

G60.Trp-5H_1

[Au]

Trp-5H

Anionic

0.065

Rowd4

?

?

Row35

Rowse

Row37

Rowsa

Rowd9

Rowsad

Rowg1

Row32

Row93

Rows4

Rowas

Rowsg

(= YR

[ d [l [l [ [ [ [ [ [ [ [ [ [

~

[ d [l [l [ [ [ [ [ [ [ [ [

[ d [l [l [ [ [ [ [ [ [ [ [ [

29 September 2016

Row ID S NPID S HBement | § Abbrevi...| § Classifi... | D MNetcell,
Rowd? G&0.CIT_1 [Au] CIT Anionic 0.037
Rowad Ge0.CTAB_1  |[Au] CTAB Cationic 0.06
Rowsa GE0.CVWIT_1 |[Au] CYVIT Anionic 0.04
Row70 a0, DOT@&B... |[Au] DOT@BOHDA  |Cationic 0.053
Row71 G60.DOT@ED.. . |[Au] COT@DOTAP  |Cationic 0.81
Row72 GG0.0TMNE_1  |[Au] CTHE Anionic 0.017
Row73 Ga0.HDA_1 [Au] HDA Cationic 0,497
Row74 Ga0.MBA_1 [Au] MEBA Anionic 0.155
Row75 Ge0.MPA_1 [Au] MPA Anionic 0,113
RowTa GA0.MUTA_1 |[Au] MLITA Cationic 2,509
Row77 GE0.NT@PS. .. |[Au] NT@PSMA-AP |Anionic 0,049
Row78 GA0.0DA_1  |[Au] ODA Cationic 0.097
Row72 Ga0.Phe-5H_1 |[Au] Phe-SH Anionic 0,058
Rowa0 Ga0.PVA_1 [Au] PVA Anionic 0.024
Rowd1 G&0.5er-5H_1 |[Au] Ser-5H Anionic 0,061
Row32 Ge0.5PP_1 [Au] SPP Anionic 0,045
Rowd3 G600, Trp-5H_1 |[Au] Trp-5H Anionic 0,065

£
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_—

Alternatively Use the Missing Value Node

* Type Missing into the Node repository 1

L] L] L] 3 ‘ ~.J
* Configure to remove rows when a missing value occurs o
r‘ ,;_“.‘ 2 A - Yy
i, " 'Q! '..' .

st '
w
b

ﬁ =

File

ey

| e

N Y

e ’
22 7 .
%
-
4 N »
y

&
Default | Individual | Flow Variables | Memary Policy

String Columns

5 String

() Do Mothing (@) Remove Row

() Most Frequent

() Fixe Value:

29 September 2016
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Column Filter

* Remove Unwanted Properties
i.e. Element (Au in all entries)

File

Column Filter | Flow Variables | Memory Palicy

(®) Manual Selection () Wildeard/Regex Selection () Type Selection
r Excude Select - Incude

Column(s): Search add > Column(s): Search
[] select all search hits [] select all search hits

S Element add all ==

§ NPID A
S Abbreviated

S Classification

D Net cell association

D Log2 transformed

D Core size

<< remove all D Density

| oMw

| Mol NP .

<< remowve

(®) Enforce exclusion () Enforce inclusion

oK Apply Cancel @

BENM

eNanoMapper
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GroupBy node

¥
* Groups per entries of a particular column or sets of cqumns%x

* If all columns are selected it is a essentially a check for
duplicate rows

* In the second tab, one can select manual aggregation
methods

File
i Table "default” - Rows: 4| Spec - Columns: 2 | Prop
Fow ID § Classifi... | | Protein ...
Row( Anionic L]
Rowil Anionic 1
Row2 Cationic L]
Row3 Cationic 1

29 September 2016
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RegEx Split

 Separate NP ID based on dot
* (F)NNICF)

File

Settings | Flow Variables | Memary Palicy

Target Column: | § NP ID

Pattern: (o*1 0N 10

[ ] Ignore Case (Case Insensitive)

[ ] Multiline

Cancel

29 September 2016
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Deleting nodes (Highlight & Delete) |8

Mode 18

A x

@ Do you really want to delete 2 nodes and 2 connections 7

[ 1 De not ask again

OK | | Cancel

BENM
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Replace Gene IDs

with Protein IDs

You will need Extract Column Header, Transpose, Cell Repl:
and Insert Column Header

* Try to derive the correct configurations, call me if you are
having issues

CS5V Reader  Missing Value Column Filter Cuhlmn Header — Insert Column
) Hoader .
@—l} T e - i E‘: Node 29 N
Cell Replacer s [
GV Reader
MNode 18 MNode 20 MNode 21 Mode 28 :H]
Mode 32
NudeF_'E Node 30
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3 more useful nodes

* Auto-binner: helps with simplification/categorization, W
visualization and classification algorithms

* Information gain: can pinpoint significant properties linked to
the class -

* Rule engine: can create a new attribute based on a custom
rule on one or more attributes

InformationGainCalculator Rule Engine
Auto-Binner

\_[}I} bﬂhb—b@

Node 33 Node 39
Mode 35

29 September 2016
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Building simple models

* Try to build a model using continuous and categorical Y
(preferably from WEKA: J48 and Linear Regression*)
* Use the scorer nodes to report accuracy/R”"2

J48 (3.7)
LinearRegression
> Qg - ) (3.7
Weka Predictor
Auto-Binner Column Filter Partitioning o {3.7)
S - Node 15 - —=
e s .
Mode 11 Remove Net Cell Association, Mode 13 Node 14 MNode 37

MP ID and Log2 Transiormed

*make sure variable is switched to continuous
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Weka Predictor

Node 38 6.7 X-Aggregator
A e - ot e
File File
i Table “default” - Rows: 84! Spec - Columns: 821 | Properties | Flow Variables Table "default” - Rows: 10 | Spec - Columns: 3 | Properties | Flow Vari
Row ID D Meteel... | D Log2tr... | D Core size | [ Density ] Mw Row ID D Errorin %| |} Sizeof...| | EmorcC...

Rowa 0,006 -7.294 14.9 19.1 197 ~ fold 0 11,111 9 1
Rowlg 0,032 -4,975 14.9 19.1 197 fold 1 25 3 2
Row22 0,016 -5.928 14.9 19.1 197 fold 2 11111 9 1
Row23 0,019 -5.736 14.9 9.1 197 fold 3 (] 3 0
Row33 0.012 -5.361 14.9 19.1 197 fald 4 (] 3 ]
Row4a4 0.01 -4.611 14.9 19.1 197 fold 5 22,222 9 2
Rowa7s 0.04 -4.652 14.9 19.1 197 fold & 12.5 3 1
Row4g 0,092 -3.436 316 9.1 197 fold 7 (] 9 0
F.ow54 0.005 -7.599 S31.6 19.1 197 fold 8 12.5 3 1
Rows 0.005 -7.09 14.9 19.1 197 fold 9 20 3 2
Row 10 0,453 -1.128 14.9 19.1 197
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* Build at least 3 different models using stratified 5 and 10—follgmw.

cross validation <7
* Report your best results }
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If we have time — KNIME Variables

e (Can use entries as variables and vice versa ‘%
* For filtering based on attribute
* For Looping Column Filter fﬂ*
* For writing multiple files 'w o N
e etc. [}_i

Mode 21

* Right Click -> Show variable ports
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Variables in KNIME

* GroupBy Anionic/Cationic

° LOOp (Start/End) Table Row
i GroupBy  Chunk Loop Start to Variable N

 Make value a variable gjb—t’i}—t’@‘\

e Use it to filter rows Column Filter/: 5 N1 Nm \RowFiter  LoopEnd |

Sab i |
!

Mode 21

(C|Z2aIucapou B i&i [=
( (®) n2s bagrsLu wpcpLd )

* Check collected results
* (per iteration/last Col)
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